
ESC|STACKVISION
NEW USER MINI TRAINING 

Getting to know the benefits of using ESC|StackVision



TODAY’S GOALS

1. CEMScape
An introduction to the StackVision CEMScape feature. Getting to know the overall 

purpose of the CEMScape components and how to use CEMScape to better 

understand your configuration and how to use CEMScape for troubleshooting.

2. DataLab and Views
We will look at the features of DataLab as well as how to create time-saving 

personalized views in StackVision.

3. CalLab and CalGas Management
Gain an understanding of the CalGas Management feature to maintain calibration 

reference values and calibration gas cylinder inventories.

4. Using StackVision Reports & Creating Linked Reports
Understand how to locate and generate standard StackVision reports including System 

Design Reports, and creating linked reports to streamline the reporting process.

5. Data Controller Essentials
Participants will identify features of the ESC 8864 Data Controller and become familiar 

with accessing and navigating the data controller remotely.

6. Introduction to StackStudio
An introduction and overview of the ESC StackStudio configuration tool.



WHAT IS A CEMS?

•Continuous Emissions Monitoring System

•A CEMS is a system that provides an efficient an effective way to:
•Monitor stack emissions on a continuous basis, and

•Provide EPA with data needed to enforce mandated reductions in the amount of 
pollutants emitted.
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COMPONENTS OF A CEMS
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DATA 
ACQUISITION 
SYSTEM (DAS)



DATA ACQUISITION SYSTEM (DAS)

The DAS serves us in two basic ways:

• It controls the automatic operations of the system, such as daily calibration
• It processes and stores system data

The ESC DAS is comprised of a Data Controller and the StackVision Server



SEVEN PRIMARY FUNCTIONS OF DAS

•Collect emissions data

•Collect Quality Assurance records (linearity, RATA, daily cals)

•Flag data to indicate whether valid and in control

•Perform Calculations



SEVEN PRIMARY FUNCTIONS OF DAS

•Substitute computer-generated values if no valid CEMS data is available (Part 75 
only) 

•Produce periodic data reports for EPA and/or states

•Create an auditable record of emissions data



THE DATA CONTROLLER

The front-end data acquisition system device that collects data from the analyzers

A data controller consists of both hardware and software elements



DATA CONTROLLER FUNCTIONS

•Translate analog signals into data values and construct averages

•Validate data based on regulation requirements

•Store average data in multiple average intervals

•Initiate daily calibrations and store calibration data



DATA CONTROLLER FUNCTIONS

•Perform calculations

•Assign flags

•Trigger alarms

•Transfer data values to and receive configuration data from the StackVision Server



DATA CONTROLLER FUNCTIONS

•Handle any necessary control functions (e.g., triggering a valve or switch)

•Report status and controller alarm conditions to the StackVision server



THE DATA CONTROLLER

Valid Data
•The EPA and other regulatory agencies not only expect you to report your emissions data, 

but they also expect it to be valid



THE DATA CONTROLLER

Constructing Data

•There must be at least one valid minute in each quarter hour

•All Valid minutes in the quarter hour are averaged to make a valid quarter

•Four valid quarterly averages are then used to construct a valid hour



CONSTRUCTING VALID HOURS 
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Typically- Base Average = 1 minute 

average

Average 1 or Ext 1= 15 minute 

average

Average 2 or Ext 2= 1 hour average 





CEMScape 
a graphical network display of your parameters and configuration



CEMSCAPE

CEMScape makes navigation easy. StackVision uses your configuration files to set up a 
graphic model of your configuration in CEMScape. This model ensures that parameter 
relationships are easily understandable.

CEMScape illustrates all parameters in your system, identifying the inputs and outputs 
of each within one easy-to-view network.



LAUNCHING CEMSCAPE

CEMScape can be launched from either the Task Explorer or 
from the View drop down menu. 



MAIN DATA AREA 

• Sources

• Data 
Controllers 

• Parameters 
• Dependent 

Parameters 

CEMScape displays objects in a series of columns and colored lines to indicate the 
relationships between them; objects are arranged from left to right, as shown in 
the example below.



CEMSCAPE TOOLBAR 

•The toolbar is a series of icons and other commands at the top of the screen and 
located beneath the main menu. The toolbar provides access to many features 
available in CEMScape.

•You can access many features from the main menu and pop-up menus. Less 
frequently used features, however, can be accessed only from the main menu.



PROPERTY TABS

Abbreviated parameter names are not always easy to understand. In CEMScape, the 
Properties pane (see example below) provides a more thorough description of any 
selected parameter. In addition to the Views tab, this pane also contains a General 
and Summary tab.

Simply click on any parameter in the main data area to display its properties in the 
Properties pane. For an explanation of the information displayed in the tabs. 



PROPERTY TABS

Range Condition Equation Constituent(s)



PROPERTY TABS 

General Tab- Source 

•If a source is selected in the main data area, the General tab displays the following 
configuration elements:

•Source—The abbreviated name of the source that is stored in the data controller.

•Description—A longer, more descriptive name of the source that has been entered in 
the parameter configuration file.



PROPERTY TABS

General Tab-Parameter

•The abbreviated name of the source that is stored in the data controller.

•Units of Measure—The unit of measure associated with the parameter (e.g., PPM, 
LB/MMBTU, LBS, etc.).

•Description—A longer, more descriptive name of the source that has been entered in 
the parameter configuration file.

•Type—The channel type.



PROPERTY TABS

Summary Tab- Parameter

•Low and high engineering units (range), which the data controller uses for scaling.

•Switch conditions for the parameter.

•The equation used to calculate the parameter (if it is a math channel).

•Constituents.



PROPERTY TABS

When a data controller is selected:

• Status tab (see example below) is displayed when a data controller object is selected in the main data area. 
This tab includes:

• A color-coded Controller box indicating the name of the controller and whether it is enabled (e.g., GREEN for 
enabled/working, RED for disabled/not working).

• A link to open the Controller Tools feature, which allows further options for working with data controllers.

• A Retrieval Status field, showing the date and time stamp of the last time polled data was received from 
the data controller for the base average data, average 1 data, average 2 data, and calibration data.

• A Manual Retrieval Status field, which is only visible if you have used the Controller Tools feature to initiate 
data retrieval for one or more controllers (see example screen below). This field displays two status bars, 
the first of which shows data retrieval progress for the selected controller, and the second of which shows 
overall status for all controllers that are currently retrieving data. 



RIGHT CLICK OPTIONS

•Each selection (Source, data controller, or Parameter) will provide additional options 
corresponding with the selection 

Source Parameter Data Controller 

View in New Window View in New Window View in New Window

QuickView QuickView QuickView

Report Network 
Report Selection
Report Network

Edit  calibration reference values 

Edit Network 
Edit Selection 
Edit Network 

Report Selection 
Report Network

Edit Selection 
Edit Network



VIEW IN NEW WINDOW

View in New Window allows you to view a specific network of 
parameters outside of the full configuration of parameters. To 
view parameters in a new window, select the parameter(s) 
desired, then right-click and select View in New Window.



QUICKVIEW

In QuickView, the current status of selected 
parameters is graphically displayed using 
numerical values and predefined flag colors. 
To open QuickView, select and right-click a 
parameter name, and then select QuickView 
from the pop-up list.



REPORT OR EDIT SELECTION 

Selecting the Report Selection or Network  will open the report selection panel. 

If Report Selection is selected, that parameter will be selected under the parameter 
selection of the report.   

If Report Network is selected, all parameters associated with the selected parameter 
will be checked in the selected report.   

The same is true for the Edit Selection or Edit Network choices.  



DATA CONTROLLER RIGHT CLICK OPTIONS

These right click options are the same as the previous options.  
In addition, the following options are available:

•Edit Calibration Reference Values- a short cut to the CalGas 
Management tool

•Controller Tools- Shortcut to the Controller Tools option, same 
as using the link in the property pane or Tools-Controller tools 
in the dropdown menus or clicking the comms status in the 
lower right corner.  



CONTROLLER TOOLS 

From Controller Tools, you can display relevant information about the status of your data controllers, 
e.g., names of your controllers, the last time each controller was polled, etc. Controller Tools also 
provides the following polling and data controller operations from the StackVision client computer: 

• Manual retrieval of average and calibration data 

• Clock synchronization 

• Controller console emulation 

• Controller tables downloading 

• Calibration control 

• Controller Tools can be launched through the link in CEMScape, from the Tools menu as shown below 
or by double clicking the satellite icon: 



LAUNCHING 
CONTROLLER TOOLS

Controller Tools can be 
launched through the link in 
CEMScape, from the Tools 
menu as shown below or by 
double clicking the satellite 
icon: 



GENERAL TAB

• General Tab provides the following:

• Status- Controller name, ID, 
Enabled/Disabled, polling status

• Control- Disable/enable selected 
controller, sync server time to data 
controller, controller emulation link 
allows remote connection to 
selected data controller.

• Calibration- provides a way to start 
calibrations corresponding with the 
selected controller

• Retrieve- provides manual polling 
options



DOWNLOAD 
TAB 

• The download tab provides easy 
download of “all” or selected 
configuration components to the 
selected data controller.   

• If the component has more than on 
segment, you can expand the 
component and select the desired 
segment(s) to download.

• Make sure to download in the listed 
order to avoid errors.   



QUESTIONS



USING DATALAB



USING DATALAB & DATALAB VIEWER

Utilize components and functions of DataLab and DataLab Viewer



DATALAB & DATALAB VIEWER



DATALAB OPTIONS 

DataLab/DataLab 
Viewer  options:

View data

Make data edits 
(DataLab only)

Print

Export data to MS 
Excel

Apply linear 
adjustments 
(DataLab only)

Perform data replacements 
and Part 75 advanced data 

replacement (DataLab only)

Launch another 
editor using a 

different interval

See flags easier 
by applying flag 

colors to the cells

Show/hide fields 
and parameters

Search for a specific 
item within a field or 

parameter 



Cross Tab View

Linear View

Chart View

DATALAB VIEWS



DATE RANGE OPTIONS

Override Date Range

Default Date Range



SELECTED PARAMETERS

Remove unwanted parameters from 

an active view by accessing the 

Parameters drop down. Uncheck the 

parameter(s) you would like removed.

Select the Source

Select parameters 

by checking 

Click 

Retrieve



VIEW IN MS EXCEL

Use the Export to Excel icon.  

At any time, the data presented to you can be 
exported to an Excel spreadsheet by selecting 
the Export icon from the toolbar, right-clicking 
anywhere in the main data area, or from the 
main menu by selecting File > Export. The 
export dialog allows you to choose the file 
location and name.



REARRANGE COLUMNS

Double-click the column header, 

the column will turn color, 

indicating that the column has 

been chosen

Drag the column header to the desired 

space, indicated by the red arrows which 

will appear to guide you.  Once you 

chose the new column position, 

StackVision automatically moves all 

column data over for you.



Select Fields in the toolbar. 

Fields are broken down into three categories: General, Permit
and Part 75.

HIDE/SHOW FIELDS



FILTERING  & SORTING OPTIONS

As in Excel, you can sort the data in ascending 
or descending order by clicking the column 
header, then using the icons  located on the 
tool bar.

The filtering options are similar 
to Windows Excel™.  Click the 
Filter  icon to choose to filter a 
column by its data. 



From a column: Click the column       header Funnel icon and 

select “(All)” from the list.

From all columns: Click the toolbar  Remove Filters icon.

REMOVING FILTERS

Remove Filters 

icon is active

This column has filters 

applied



Add a condition

Execute the filter

CUSTOM FILTERING

DataLab also allows custom filtering. With the custom filtering option, values may be viewed 
according to user-specified operators and operands (e.g., equal to, does not equal, less than, less 
than or equal to, greater than, greater than or equal to). 



SUMMARIES OF SELECTED DATA

Select the type of 

summary to display 

View the summarized data displayed 

below the column of the selected 

parameter.



SUMMARIES

Using the Add Summaries icon from the tool bar 
or right-click menu will apply ALL summaries to 
ALL columns.



Using the Add Summaries icon column 
heading lets the user choose which 
summaries to apply.

SUMMARIES



Data is displayed in   
chronological order.

Parameter values and 
fields are in columns.

Dates and times are 
in rows. 

CROSS TAB VIEW

The CrossTab view makes is easy for users to find 
given parameter averages at a specific timeframe



Linear view is in 
chronological order.

Shows all parameter 
and field information 

for a given hour.

LINEAR VIEW



CHART VIEW
Chart view displays a graph of selected data, showing the 
value changes for any date selection.



CUSTOMIZE YOUR CHART

Right-click in chart area to open a Chart Customization box. 



ZOOM TO SPECIFIC DATA

Click Return to Normal button.



LINEAR ADJUSTMENTS

The Linear Adjustment tool is 
used to apply linear changes 
to selected data cells.



Replace an entire column by clicking 

on the top of the column and selecting  

[Ctrl-H] 

The Replace window will appear and 

allow the user to change the selected 

values.

REPLACE VALUES



Click the white rectangular 

bar located next to the scroll 

bar and drag it to the 

desired position to freeze 

the selected parameters.

FREEZE PANES



View data with different intervals—view hourly average data, then view the same 
data with minute averages

Hourly data, 

with hour 

selected

Minute

data for 

the 

selected 

hour

LAUNCH DATALAB W/ DIFFERENT INTERVAL



Click Show Flag Color icon to color-code 
flagged data so it is easier to distinguish it 

from clean data. 

Click Show Color Preferences       
icon for an explanation of flag colors.

FLAG COLORS



SHOW ROUNDED VALUES

Display values with their full precision rather than rounded values



RESTORE FROM ORIGINAL

In Linear View –
After making changes, restore values from the original data by clicking the Restore from Original icon.  

Values Restored to 
Original

Changes MadeOriginal Values



CREATING AND SAVING VIEWS 
IN DATALAB

Saving and recalling a custom View can save time and 
frustration. Once a View is created and saved, that 
View will apply to other feature areas. Views can be 
managed by users with administrative rights under 
the configurations tab on the toolbar. A View can be 
saved as a User View or a Shared View. If saved as a 
User View, only the users with the same log in 
privileges will be able to access the view. If saved as a 
Shared View, anyone who logs on to the system will 
be able to access and edit the view.



CREATING VIEWS

Select Parameters

Retrieve Data 

Apply filters and 
summaries 

Click the Save View
icon.

Name the View

Choose User or 
Shared. If a View with 
the same name exists, 

click the Overwrite
option to save changes

Select 
parameters, 

filters, 
summaries, etc



USER ONLY OR SHARED VIEW

•If a view is saved as a Shared View, all users will have access to select and open the 
view.  Only the user who created (owns) the view will be able to edit the view.

•If not a shared view, the view will only be available when the owner of the view is 
logged into StackVision.   

•Subfolders can be created on the views pane by right clicking and selecting New 
Folder. Put the views in the new folder using drag/drop. 

•SV administrators can use the Views Administration option to change ownership, 
status (shared/user) import or export  and delete views.  





USING CALLAB AND 
CALGAS MANAGEMENT

A look at the benefits and functionality of using the ESC|StackVIsion CalLab feature 

to review historical calibration results and supporting data



CALLAB AND CAL GAS MANAGEMENT

CalLab- A tool to be able to review (and edit) calibration results

CalGas Management-A tool to manage reference 
values, cylinders and PGVP data



DAILY CALIBRATION

Daily calibrations must be run on all analyzers, opacity monitors and stack flow 
monitors at the following times

•On any day the unit combusts fuel
•Within

• 26 hours after the last passed online calibration, or 
• Eight clock hours of unit startup

•What happens if the test fails?



DAILY CALIBRATION

To check the status of the daily calibration:

1.  Select CalLab from the Home task pane.
• Select the Parameters
• Select the Date Range
• Click Retrieve

2.  Run Calibration Reports.

Home task pane  Calibration Detail Report

or

Reports  Calibration Detail Report



INITIATE A CALIBRATION

Calibrations can be initiated using Controller Tools

Access Controller Tools through 

▪ Tools-Controller Tools

▪ Link from CEMScape Logger properties

▪ In CEMScape, select logger and right click, select Controller 
Tools

▪ Double click communication status icon in lower left of main 
StackVision screen 



OPENING CALLAB

•CalLab can be opened from the StackVision 
Task Explorer or from the Tools menu.



RETRIEVING CALIBRATION DATA

•Select a source and one or more parameters.

•Select the date range to be returned.

•Click “Retrieve”.



CALLAB

The CalLab screen contains the following tabs:
•Calibrations
•7-Day Calibrations
•Cycle Times



CALIBRATIONS TAB

•Data can be sorted using 
the funnel icons  

•Calibration gas Reference 
Values can be changed

•Calibrations can be added 
using minute data

The first tab, Calibrations, shows the selected Parameters, the Reference and 
CEMS values, the error limit and error, as well as the Status of the test 
(Pass/Fail/Maintenance)



ADDITIONAL FIELDS 

The Details Option in Fields will display items such as:

•Span

• Injection Level 

•Alternate performance specification-ASPF

•Unit of Measurement 

•Maintenance 

•And many More!



CALIBRATION REPORTS 

Two reports to check historical calibration data:

•Calibration Detail report- Reports historical daily or quarterly calibration events for the 
date/time range, Plant, Source, Parameter specified.

•Calibration Trending Report -Reports a line chart of calibration events for the date/time 
range, Plant, Source, and Parameter specified.



SYSTEM DESIGN REPORTS
The Data Controller system design 
report will display all calibration 
sequences configured in your system.  



SPECIAL TESTS
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“Special” calibration test data can also be displayed using the CalLab tool.  

Special tests include:

▪ 7 Day calibration error check 

▪ Cycle time response test



CAL GAS MANAGEMENT TOOL

CalGas Management is a tool for managing reference values, 
cylinders and PGVP data

▪ Access the CalGas 
Management from:
▪ Tool bar- CalGas 

Management

▪ Task Explorer-Tools-CalGas 
Management

▪ CEMScape- Select Data 
Controller (Logger)-right 
click- Select Edit 
Calibration Reference 
Values



ACTIVE REFERENCES TAB

All current calibration references are listed in the Active 
References tab 

•Filter by checking and un-checking Sources or Parameters 
in the Selections pane.

•Use if Cylinder Templates are not created



ACTIVE REFERENCES TAB

•If Cylinder Templates are created,
•Yield signs       indicate that the reference has a template, but a cylinder was not assigned.
•Signs disappear once a cylinder has been assigned on the Cylinders tab.
•Do not edit from this screen if templates are used.

The Overwrite icon        will 

appear next to the reference 

value.  Changes should be 

made on the Cylinders tab.



CYLINDERS TAB

•Templates show in the In-Service portion of the screen

•Gas bottles can be entered either into Inventory or directly In-Service.



ADDING A CYLINDER

•Click the Add icon       , or
•Select Edit  Add, or
•Right-click in the Inventory section and 

choose Add

Fill in the desired fields, and click OK. Only 
the Serial Number, Expiration Date and 
Gases are required.



EDITING A CYLINDER
•Highlight the cylinder  select the Edit icon 
•Hover over the cylinder to display the Tool Tips  Select Edit 

Cylinder

All options available when 

adding the cylinder are 

available in the edit window.



INVENTORY TO IN-SERVICE

•All templates in the In-Service 
window should have an assigned 
cylinder

•To assign a cylinder, click and drag 
the cylinder to the desired 
template.

Only templates that match the cylinder’s gases 
span values will show as an available template.



SAVE AND DOWNLOAD

•Before any of the changes made will take effect in the data controller, you must save 
and download the changes to the controller.

•Use the Save and Download icon.



REPLACING A CYLINDER

•Select the cylinder  drag and drop on top 
of the Template, or 

•Hover over the cylinder  Select the 
Replace with New



ACTIVE REFERENCES 

•Once a cylinder is placed “In Service” and 
save/downloaded, active references will also be 
updated.   





STACKVISION REPORTS
Understanding how to generate StackVision reports and work with SQL Server 

Reporting Services to create and customize linked reports



STACKVISION REPORTS



AVERAGE DATA REPORT OPENING SCREEN



AVERAGE DATA REPORT DROPDOWN EXAMPLES

Click on “Show 

Report” when All 

Selections are 

made



REPORT VIEW AFTER SELECTIONS



PRINT/EXPORT CHOICES

Print from any 

Installed Printer

Dropdown to export to 

any of these File Formats

Page Setup 

for Print



SQL  REPORTING SERVICES

•One of three servers supporting your StackVision application. 

•A web service, an application specifically designed to support multi-machine 
interactions over a network



OVERVIEW OF SQL REPORTING SERVICES

Linked reports are “linked” to the original report located on the Reporting Services (RS) 
server. The linked report can have defaults set to enable quick retrieval and display of 
data. This is helpful for those users needing recurring reports or those users who are not 
regular users of StackVision.

Stackvision linked reports are located under the Home page of the SQL Server Reporting 
Services website. Each file presents a separate report. Each folder represents a 
subdirectory under the Reports pane in StackVision.

StackVisionReports represents the SQL Data Source—meaning, all the reportable data 
compiled in your StackVision user database is being used in the StackVision reports 
(Custom, Linked, and/or Default).



CUSTOM OR LINKED?

•A “Custom” report is a report created by ESC staff if there is no other StackVision 
report that meets the needs of the site/plant. 

•A “Linked” report is linked to one of the standard StackVision reports, only with all 
settings and options loaded by default. 

•Custom reports- Should be created by ESC staff

•Linked reports-Created by users, or can be created by ESC staff to aid in your 
reporting



AUTOMATED OUTPUT OF REPORTS

Any “standard” StackVision report can be set to auto generate and then sent to 
specific email address and/or printers on the same network as the SV server or 
attached to the server. This is accomplished using the Task Scheduler located under 
Configuration-Task Scheduler

Output of Linked reports can be scheduled using the Group Reports Generator tool 
located under Reports 



GROUP REPORT GENERATOR 

•The Group Report Generator can only be used for linked reports.

•Output can be sent to a printer, email addresses, a file or  opened in 
StackVision.  Each report will be created as an individual file.



ACCESSING SQL REPORTING SERVICES

•Start by opening a web browser (IE, Chrome, etc.)

In the address bar, enter the name of the server where the 

reports are located followed by reports/pages/folder.aspx



IN THE BEGINNING….

•Once Reporting Services opens, click the “…” symbol next to a 
report to open a dropdown menu.  

From the dropdown menu, select “Manage” 



LINKED REPORT

Click on “Create 

linked report” tab



Give the report a 

unique Name and a 

Description

WHAT'S IN A NAME?  



Click on Location and select 

the Custom folder or a 

subfolder that you want the 

new report to reside in.

LOCATION, LOCATION, LOCATION



REPORT CREATION

•Click “Select” if location was changed

•Click “Create” to finish creating the new linked report



MANAGING YOUR NEW REPORT

•You will now be taken to the “Manage” screen for your new linked report.

Click on 

Parameters to 

manage 

report defaults 

from this page



SETTING LINKED REPORT DEFAULTS

•Click the “Use default” checkbox.

•Enter the default value in the drop 
down box in the Default Value column. 
Enter these values in ALL CAPITAL 
letters, followed by the enter key. Some 
fields will provide check boxes in the 
drop down box for easy selection.

•Parameter names must exactly match 
the names in the configuration. 

•Click Apply to set the defaults. Report 
will open and generate results based 
on these defaults.

Don’t forget to click Apply!



ENTER TEXT

•All text entered must be in uppercase and without any formatting or punctuation.   

•Although the display will have commas and such, multiple items must be entered 
individually, pressing the enter key after each entry is made. 



HIDDEN FEATURES

Particular options can be hidden from the report by 
changing the Visibility to “Hidden”.  



HIDDEN OPTIONS 

These 
options 
have been 
hidden



NEW REPORT IN CUSTOM MENU



DELETING LINKED REPORTS 

Linked reports can be deleted individually, using the drop 
down menu on the report

OR

From List view on any folder, select which reports to delete 
and click Delete on the header bar



RESTORING ORIGINAL REPORTS 

•If the original report is edited and needs to be replaced, use 
the Upload option from the Home Screen.  

•You will need to be able to access the StackVision application 
files.   

•All StackVision reports can be found in 
x:\StackVision\Application\Resources\Reports



MORE ON SQL REPORTING SERVICES

There are many additional features of Microsoft SQL Server Reporting Services. Entire 
courses and even careers are dedicated to using Microsoft SQL Server Reporting 
Services to create custom reports and to utilizing the full advantages of Microsoft SQL 
Server Reporting Services.

The Microsoft website offers free overviews and guided tours of SQL Server Reporting 
Services:

http://www.microsoft.com/sql/technologies/reporting

There are several training opportunities, tutorials and books available online and in 
hard copy. 

http://www.microsoft.com/sql/technologies/reporting


DATA CONTROLLER
Collecting Data with the ESC|8864 Data Controller



OVERVIEW OF ESC DATA CONTROLLER

The ESC Model 8864 Data System Controller is a microprocessor-based data 
acquisition system designed to acquire, process, store, report, and telemeter data in 
a multi-tasking environment. The 8864 is designed around an expansion bus that 
gives the user great flexibility in configuring the unit with almost any combination of 
input and output types.





FEATURES OF ESC DATA CONTROLLER

•User-friendly menu-driven interface with “plain English” prompts. 

•Supports several channel types, including MODBUS, math pack, stream-
switching, time-online, rolling average, counter, and meteorological. 

•Simple and complex cal programs, providing both ease of use and flexibility. 

•Full-screen real-time and historical displays of data values. 

•Flexible alarming system, no limit on number of alarms per channel. 

•Six-level password protection with user-configured passwords. 

•Data storage configurable for each channel and averaging interval, to allow 
optimum use of available data storage on the compact flash card; also permits 
“snapshot” storage of one-second readings.  

•All configurations may be set via software (no DIP switch configs required).  

•Up to 999 parameters per data controller can be monitored. 



INTERACTING WITH ESC DATA CONTROLLER

There are basically two methods of interacting with the data controller:

1. Touch Screen (Color)

2. MDI (Menu Driven Interface) (Black and white – old style interaction)



TOUCHSCREEN







THE HOME SCREEN



HOME SCREEN NAVIGATION BUTTONS



CAL STATUS SCREEN

Auto—Automatic Calibration.
Inst Ctl—Instrument Controlled Calibration.  
Ext Init—Externally Initiated Calibration.  
User—User Initiated Calibration.  
User DI—User Initiated Calibration with 

Confirming Digital Input.  
Menu—Interactive (Menu) Calibration.  

See Complex Calibrations for detailed 
descriptions on each of these calibration types. 

• Sequences that are currently running are displayed with a triple 
asterisk indicator (***), the phase that the calibration is currently in, 
and the time remaining in the phase.  

• Sequences that are queued to start show a status of PENDING.  
• Scheduled sequences show a status of Runs at mm/dd/yy hh:mm. 

1. Sequence column—List of calibration names.
2.Type column—Type of calibration sequence:

3. Status column—Current status of the calibration sequence:

4. Last column—Status of the most recently completed calibration sequence:
• For an actively running cal, this column shows whether the cal has 

passed all previous phases (Pass) or failed one of them (Fail).  
• For sequences that have never run, this column shows a dashed

line (“-----”).



ACTIVE CAL DETAIL SCREEN



CAL SEQUENCE SCREEN



MORE ON CAL SEQUENCE SCREEN



The Graphs screen can be accessed at any
time by pressing the Graphs button on the 
left side of the touchscreen. 

This screen allows quick access to current 
one-minute averages for a chosen channel. 

GRAPHS SCREEN



DIGITAL I/O



THE TOUCH SCREEN MORE BUTTON (MDI)



DATA CONTROLLER FLAGS (VALIDATION/INFORMATIONAL) 





INTRODUCTION TO 
ESC|STACKSTUDIO

Viewing and modifying your StackVision configuration



 Select StackStudio from the Task Explorer; or

 Select Configuration > StackStudio

LAUNCHING STACKSTUDIO FROM STACKVISION



STACKSTUDIO SCREEN

StackStudio will open in its 

own application window.

1. Click on Server to 

pull current config in.

2. Click on File to pull 

saved config in 

(.svconfig file).



LOGGING IN

1. Uncheck “Use Windows….”

2. Type in admin rights User 

Name and Password.

3. Click on Login.



STACKSTUDIO MAIN WINDOW



OPENING THE CONFIGURATION FROM MENU

 “Open” Dropdown: 

 Server - can check out 

“Lock”

 Local Storage - more of a 

temp file

 File - open from a saved 

file name



CHECK OUT

 A locked configuration prevents others from modifying the 

configuration, it is a way to prepare changes when a large 

amount of work needs to be done to make sure only your 

changes are implemented.



CANCEL A CHECK OUT

 Two situations in which you can cancel a check out:

1. If you have checked out the configuration, you may cancel 

your own check out once you complete your edits or you 

save your changes to server

2. If the StackVision user who checked out the configuration is 

unavailable but the configuration must be updated 

immediately, then an administrative user may cancel out the 

other user’s check out

Overriding a lock on the configuration will impair the original 
user from checking in the configuration. All configuration 

changes made by the original user will be lost. Use this 

feature with caution.



CANCEL A CHECK OUT

 Navigate to Change Control > Cancel Check Out

from the File menu



NAVIGATING STACKSTUDIO

•StackStudio Home Screen
1. The Ribbon
2. Toolbar
3. File Menu
4. StackStudio Explorer
5. Configuration Workspace
6. Status Bar
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Home

View

THE RIBBON



TOOLBAR

•Icons that represent commonly used functions within StackStudio



FILE MENU

• The starting point to using StackStudio is the File menu.  



STACKSTUDIO EXPLORER

•Logically arranged list of available 
Configuration Editors representing key 
configuration options

•StackStudio Explorer can be minimized or 
docked in the Explorer Pane



CONFIGURATION EDITOR
•Each configuration editor has two  sections:

•Grid View
•Form View 



CONFIGURATION WORKSPACE

•Small icons around the configuration editor allow you to customize the layout of 
the workspace.



EDITORS FOR CONFIGURATION STEPS

Data Definition and Control System Settings



EDITORS FOR CONFIGURATION STEPS

Data Processing Data Reporting



TIPS AND TRICKS



VERTICAL SPLIT



VERTICAL SPLIT



GROUP BY FIELD



MULTI-COLUMN FILTER



CLEAR ALL FILTERS



BRING FORM FIELDS INTO GRID VIEW



HIDE UNNECESSARY COLUMNS



RESTORE HIDDEN COLUMNS



QUESTIONS



WORKING IN 
ESC|STACKSTUDIO

Live walk-through of a StackVision configuration



LIVE DEMO


